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1. Introduction 
This document acts as user manual for the QGIS Prowater-plugin. This tool can be used to quantify the 

effect of a number of Ecosystem-based adaptations on the delivery of Ecosystem Services in the 2 Seas 

region. This tool was developed in the Interreg 2 seas PROWATER project. 

 

2. Installation procedure 
The installation procedure is straightforward, however installation rights are required to install QGIS 

on a computer. The tool works correctly in Windows 7, 10 and 11, but has not been tested for other 

operating systems.  

 

2.1. Installation QGIS 

 
The plugin works correctly in QGIS3 and has been tested for QGIS 3.22. QGIS is Free and Open Source 

Software (FOSS) and can be downloaded from www.qgis.org.   

 

2.2. Installation plugin 

 
The tool consists of 2 parts, plugin and database, which must be installed separately on the computer 

(Figure 1). Because the database is quite large, it was decided to disconnect it from the plugin. This 

gives the user the flexibility to place each part where it suits him/her best. Due to size constraints, 

different layers of the database can be downloaded separately and be placed in their correct position 

in the database afterwards.   

 

 

Figure 1: Structure of the Prowater-tool. 

 

 

 
 

http://www.qgis.org/
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1. The first part, the QGIS Plugin, contains the scripts which builds the interface of the plugin in 

QGIS. This folder “prowater” must be placed in a specific user-related folder. This can be found 

in QGIS via: 

Settings -> User profiles -> Open Active Profile folder.  

In this folder the folder python/plugins can be found. 

If the folder 'plugins' is not present in the folder 'python', it can also be created manually. 

After installation and when restarting QGIS, the plugin will appear in the list of installed 

plugins. The plugin then needs to be activated in the list of plugins, which can be found in the 

menu bar under Plugins. 

➢ Select Manage and Install Plugins 

➢ Go to Installed 

➢ Activate ‘Prowater’ by checking the box. 

The PROWATER tool will then become available directly under Plugins in the menu bar. 

2. The 2nd part, the database, contains several folders needed to run the different models as 

well as a folder to store intermediate results. This 2nd part can be placed anywhere on the 

computer but requires a considerable amount of memory. In this part the analyzes are 

performed and possibly saved. This part contains 4 folders that are name sensitive. This 

naming should not be changed, or the plugin will not work correctly. It is also best to keep the 

names of the layers in the model consistent with what is shown below. 

• _Geodatabase = Database with a land cover map and maps with the mean highest 

and lowest groundwater for a subpart of the 2 seas region. 

o Landcover.tif 

o MHG.tif 

o MLG.tif 

• _Models = Contains data used for the different calculations of the ecosystem services. 

o Model_drainage 

o Model_health 

▪ population_ha.tif 

o Model_infiltration 

▪ texture.tif 

o Model_soil_c 

▪ clay.tif 

▪ sand.tif 

▪ podzol.tif 

o Model_soil_np 

• _TempFolder = Contains temporary data that is placed inside this folder during 

calculations. This data gets automatically deleted afterwards.  

• _Legends = qml files 

Some layers of the database have been split up in parts. For the tool to work correctly, these parts 

either have to be renamed (remove the regional part of the file name so it is equal to the one in the 

overview above) or the different parts have to be merged together. This is the case for the layers land 

cover, MHG and MLG.  
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The land cover layer has been split into 2 parts: landcover_FL_NL and landcover_UK. Both the MHG 

and MLG layer have been split into 4 parts: 1 part for Flanders and the Netherlands (MHG_FL_NL and 

MLG_FL_NL) and the other parts compromising parts of the UK: Southwest, Southeast and Anglia 

(Figure 2). 

 

Figure 2: Part of the regional map of the UK relevant  to the 2Seas region. 

How to merge the different parts into 1 layer? 

1. Open the different parts in QGIS. 

2. Go to Raster -> Miscellaneous -> Merge 

3. Input layers: Select the different subparts of the layer you want to merge. Don’t tick any of 

the boxes. 

4. Output data type: The data type depends on the layer. For MLG and MHG it should be Int16, 

for land cover UInt16. 

5. Save to file: Here you should provide the save location and name. You can save the merged 

layer under database_PROWATER/_Geodatabase/ and give it the name landcover/MHG/MLG 

.tif. 

 

3. Geodatabase 

3.1. Land cover 

 
A tool only works with correct input data. To facilitate the use of the tool, we have provided a 

geodatabase with all the maps that are needed to make the tool work. This geodatabase is based on 

EU-wide datasets on land cover, soil and topography. Downside of these datasets is that they have a 

poor thematic and spatial resolution and may be outdated. Our suggestion is to use local, more 

accurate datasets instead of the data layers in the geodatabase. The data layers in the GDB can be 

replaced if they use exactly the same categories, projection and resolution. The GDB allows the user 

to explore the tool without investing too much time in the development of a local, more accurate 

dataset. 
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Land cover data is retrieved from multiple sources. All data sources are remote sensing based, which 

has several drawbacks. The RS-based methods rely on multiple images that cover a time span of 

multiple years. This implies that dynamic land cover – often seen on agricultural fields – is not well 

captured. Crop rotations will result in a single class, namely arable. It would be of value to capture 

typical rotations in agricultural crops (e.g. grassland – maize – potatoes), especially because some 

rotations are more soil and infiltration friendly than others. RS-based land cover mapping also 

performs very poor for natural vegetation. The RS-signal is a mixture of many species and has a spatial 

resolution of 5-10 meters. 

 

 We built the PROWATER LC map using detailed and accurate datasets where available and 

resorting to less accurate datasets where needed. The pan-European High Resolution Layers 

(HRL) provide information on specific land cover characteristics, and are complementary to 

land cover / land use mapping such as in the CORINE land cover (CLC) or  S2GLC 2017 datasets. 

The HRLs are produced from satellite imagery through a combination of automatic processing 

and interactive rule based classification. Since the 2015 reference year, the production is 

increasingly based on time series of satellite images from a number of different sensors, 

including the combination of optical and radar data. The main sources are now (since the 2018 

reference year) the Sentinel Satellites (in particular Sentinel-2 and Sentinel-1). Since 2018, the 

products have increased in resolution to 10 meters, thus following the source resolution of 

the Sentinel-2 imagery. 

 Five themes have been identified so far, corresponding with the main themes from CLC, i.e. 

the level of sealed soil (imperviousness), tree cover density and forest type, grasslands, 

wetness and water, and small woody features. We use three of these themes to develop the 

PROWATER LC-map. The wetness and water and the grassland layer have been less consistent 

over time (2015-2018). 

o The VHR Imperviousness layer maps the % of soil sealing at 10 m resolution. The layers 

allows to specify the % of imperviousness at pixel level. If a pixel is mapped as 20% 

imperviousness, we assume the remainder to be grassland.  

o The VHR Forests layer maps the tree cover density (%) and the dominant leaf type 

(broadleaved versus coniferous). 

o The HRL Small Woody Features (SWF) maps types of linear or patchy structures of 

woody/scrubby/bushy vegetation . It is a Copernicus Land mapping product, which 

provides harmonized information on linear structures such as hedgerows, as well as 

patches of woody features across the EEA38+UK countries. 

 

 The second basis of the PROWATER LC-map is the S2GLC map. The S2GLC 2017 dataset is 

delivered with 10 m spatial resolution with thematic legend composed of 13 land cover 

classes. The Sentinel-2 Global Land Cover (S2GLC) project was founded by the European Space 

Agency (ESA) through its Scientific Exploitation of Operational Missions (SEOM) element. This 

map has a poor thematic resolution.  

 The third basis of the PROWATER LC-map is CORINE Land Cover. CLC datasets are based on 

the classification of satellite images produced by the national teams of the participating 

countries - the EEA members and cooperating countries (EEA39). National CLC inventories are 

then further integrated into a seamless land cover map of Europe. The resulting European 

database relies on standard methodology and nomenclature with following base parameters: 

44 classes in the hierarchical 3-level CLC nomenclature. All features in original vector database 

are delineated and classified on satellite images according to CLC specifications i.e. with better 

than 100 m positional accuracy and 25 ha minimum mapping unit.  
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OID Value_1 Count_1 Legend Source 
 

OID Value_1 Count_1 Legend Source 

0 0 14975717 NoData   
 

30 3101 2221635 Natural grasland CORINE 

1 2100 1889649 Broadleaf forest of unknown density VHRL 
 

31 3201 13409108 Agricultural grasland CORINE 

2 2110 60718 
Broadleaf forest 10-20 % canopy 
density VHRL 

 
32 4000 1,32E+08 Moors and heathland S2GLC 

3 2120 281874 
Broadleaf forest 20-30 % canopy 
density VHRL 

 
33 5200 532704 Dunes and beaches CORINE 

4 2130 1253816 
Broadleaf forest 30-40 % canopy 
density VHRL 

 
34 6000 3.09E+08 Cropland (probably) S2GLC only 

5 2140 4721931 
Broadleaf forest 40-50 % canopy 
density VHRL 

 
35 6112 16533858 Cropland (certain) 

S2GLG + 
CORINE 

6 2150 12724644 
Broadleaf forest 50-60 % canopy 
density VHRL 

 
36 6204 217803 Orchards CORINE 

7 2160 23428552 
Broadleaf forest 60-70 % canopy 
density VHRL 

 
37 6300 227948 Vineyards CORINE 

8 2170 30831736 
Broadleaf forest 70-80 % canopy 
density VHRL 

 
38 7000 7806734 Swamp S2GLC 

9 2180 25161594 
Broadleaf forest 80-90 % canopy 
density VHRL 

 
39 7101 6533888 Marshland S2GLC 

10 2190 10247369 
Broadleaf forest 90-100 % canopy 
density VHRL 

 
40 8101 203951 Tidal mudflats CORINE 

11 2200 250101 Coniferous forest of unknown density VHRL 
 

41 8201 109384 Tidal marshes CORINE 

12 2210 725 
Coniferous forest 10-20 % canopy 
density VHRL 

 
42 9010 6812082 Urban 10-20 %paved VHRL 

13 2220 3206 
Coniferous forest 20-30 % canopy 
density VHRL 

 
43 9020 14269300 Urban 20-30 % paved VHRL 

14 2230 21425 
Coniferous forest 30-40 % canopy 
density VHRL 

 
44 9030 18524130 Urban 30-40 % paved VHRL 

15 2240 118924 
Coniferous forest 40-50 % canopy 
density VHRL 

 
45 9040 17939820 Urban 40-50 % paved VHRL 

16 2250 686165 
Coniferous forest 50-60 % canopy 
density VHRL 

 
46 9050 15606911 Urban 50-60 % paved VHRL 

17 2260 3291823 
Coniferous forest 60-70 % canopy 
density VHRL 

 
47 9060 12733981 Urban 60-70 % paved VHRL 

18 2270 9476250 
Coniferous forest 70-80 % canopy 
density VHRL 

 
48 9070 10381692 Urban 70-80 % paved VHRL 

19 2280 7355626 
Coniferous forest 80-90 % canopy 
density VHRL 

 
49 9080 8690502 Urban 80-90 % paved VHRL 

20 2290 1427250 
Coniferous forest 90-100 % canopy 
density VHRL 

 
50 9090 26441575 

Urban 90-100 % 
paved VHRL 

21 2310 97405 
Undefined forest 10-20 % canopy 
density VHRL 

 
51 10000 23501445 Water S2GLC 

22 2320 401806 
Undefined forest 20-30 % canopy 
density VHRL 

 
52 10200 26551 Tidal water CORINE 

23 2330 1427423 
Undefined forest 30-40 % canopy 
density VHRL 

 
53 10204 86271 Rivers and canals CORINE 

24 2340 3581723 
Undefined forest 40-50 % canopy 
density VHRL 

 
54 10300 95461 Sea CORINE 

25 2350 5361158 
Undefined forest 50-60 % canopy 
density VHRL 

 
55 11000 16516 Bare rocks CORINE 

26 2360 4604041 
Undefined forest 60-70 % canopy 
density VHRL 

 
          

27 2370 2502592 
Undefined forest 70-80 % canopy 
density VHRL 

 
          

28 2380 1006515 
Undefined forest 80-90 % canopy 
density VHRL 

 
          

29 2390 290343 
Undefined forest 90-100 % canopy 
density VHRL 

 
          

Figure 3: Overview of the Prowater Land cover Map and data sources for each category 
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3.2. Mean highest (MHG) and lowest (MLG) groundwater level 

 
The mean high groundwater (MHG) gives an indication of the average groundwater table at the end 

of the winter season. The mean lowest groundwater level (MLG) gives an indication of the average 

groundwater table at the end of the growing season over a longer period. 

The depth at which the soil is water saturated varies a lot and depends on the preceding weather 

conditions. Preferably such data is locally available and can be used to replace the datasets in the GDB. 

Unfortunately, data on soil water levels is very difficult to obtain and is generally an output of 

hydrological models. A lot of the scenarios involve the reduction of drainage and the manipulation of 

water levels to increase water retention in the soil. MHG and MLG may also be deducted from 

vegetation and local measurements.  

To allow the exploration of the Output 2 tool, we developed these MHG and MLG maps for the GDB. 

It is however very unlikely that they reflect a real local situation.  

The original MHG/MLG map of Flanders is an interpolation of the drainage classes from the digital soil 

map of the Flemish region (1970) (AGIV,2006), with topographic corrections based on the DTM for 

Flanders (AGIV, 2014). The basis of the original soil map of Flanders are soil samples taken anno 1960-

1970. Through the rusty mottles or the oxidation-reduction front in the soil samples, the drainage 

class of a soil can be determined. Based on a combination of the drainage and texture class an 

indicative designation of the depth of groundwater relative to the topography was developed 

(Stuurman et al., 2002). These estimates of groundwater depth are the mean for each polygon of the 

soil map. Inside polygons with identical texture and drainage, significant topographic variations can 

be identified. The indication of the depth of groundwater should therefore be seen as the mean state 

of a larger zone. The availability of the DTM in a higher resolution (DHM Flanders II) enabled the 

selection of only the topographic mean locations. These could then be used  for interpolation to obtain 

an even more detailed groundwater table layer. Similar to the way the MHG layer was developed, 

MLG can be deducted from soil samples, more specifically the reduction front in soil samples. This can 

also be linked to drainage classes. Based on a combination of the drainage and texture class an 

indicative designation of the depth of groundwater relative to the topography was developed 

(Stuurman et al., 2002). However in dry soil classes there was insufficient differentiation. The 

relationship between drainage classes and the difference between MHG and MLG was then further 

extrapolated using the water system map.  

This high resolution Flemish dataset has been used to extrapolate a MHG and MLG for the other parts 

of the 2 Seas region, by using a regression model.  A regression model provides a function that 

describes the relationship between one or more independent variables and a response, dependent, 

or target variable. So we used the water system map (output 3) to predict the MHG and MLG, based 

on the data available for the Flemish Region. Evidently, the performance of this function is not very 

high and even questionable outside the Flemish Region. However, this was the best available method 

to develop such a map for the 2 Seas Region. 
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3.3. Other layers 

 
The models of the ecosystem services sometimes contain other layers that will be shortly presented 

here. These layers are provided with the database, but can be replaced by others if more accurate 

(local) data is present. 

3.3.1. Texture 
The map of texture is used in the calculations of the ecosystem service of 

infiltration/evapotranspiration/runoff and is derived from data from LUCAS (Ballabio et al., 2016).   

This dataset recognizes 4 different textures:  Sand, loam, sandy loam and clay. As the original data is 

very coarse (500x500m) and binary, we opted to increase the resolution and make the changes more 

gradual by selecting the middle of a pixel and using these datapoints to interpolate between values. 

This creates then a map with 4 bands, one for each soil texture. Band 1 corresponds with loam, band 

2 with sand, band 3 with clay and band 4 with sandy loam. 

3.3.2. Sand/Clay/Podzol 
These maps are used in the calculation of the ecosystem service soil carbon. The clay and sand content 

maps are based on data from LUCAS (Ballabio et al., 2016). These maps have a pixel size of 500x500m. 

For this reasons again the pixel size was artificially raised to 10x10m by choosing the middle of the 

original pixels and interpolating between these. 

Podzols are soil types with a spodic horizon, which has a large soil organic carbon content. For this 

reason, these soils are part of the calculation of soil carbon.  

3.3.3. Population 
The map with the population density per ha is used in the calculation of the ecosystem service health. 

The layer has a resolution of 100x100m. 
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4. Plugin 

4.1. Scenario development 

4.1.1. Extract case study 

 
Description 

Module 1.1 retrieves the GIS data for the research area from the _Geodatabase. In this way 

calculations in the other modules can be limited to the area of interest. The datasets produced can 

then be used further in the plugin. 

Method 

Module 1.1 extracts parts from the different geodatabase layers based on a study site shapefile, 
created by the user. These partial datasets can then be used further in the other modules. The module 
only requires an output folder and defines the result names. The provided shapefile must be in 
coordinate system EPSG 3035.  

 

4.1.2. Develop LC scenario 

 
Description 

Module 1.2 gives the user the possibility to set up scenarios with an adapted land cover. The original 

land cover map from the geodatabase or, if available, a more precise local land cover map can be used 

as input to then be adjusted through this module. The module offers the possibility to define sub-

areas within which one or more changes take place. Module 1.2 uses user-defined shapefiles and 

defined conversion rules for this, which are assigned to the different shapefiles. The module will then 

combine both and integrate them into one map. 

The advantage of this module is that elements that need to be preserved are simply taken over from 

the original maps. Streets, houses, waterways, etc. can thus be kept the same as they are currently. In 

addition, scenarios can be easily modified by adding, modifying, or removing conversion rules or 

changing the shape of the shapefiles. The result is a system that gives the user maximum flexibility. 

The naming of the output map can be determined by the user himself. 

 

 

 

Required information in the module 

   Type Description 

1 
Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select the case study area Shapefile Select the shapefile which delineates the study site 

3 Give a location to save the 

results. 
Folder Select a folder where the results can be saved. 
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Method 

In this module, the user must create several files: a txt-file that contains the necessary customization 

rules and a number of shapefiles to indicate the zones in which certain changes take place. 

These shapefiles delineate the areas to which the changes will be applied. Within a zone, forest can 

be moved to grassland, while the forest remains outside. One shapefile can be used for processing 

several conversions. Settings must be correct when the shapefiles are created: 

• The shapefile must have the same name as in the Excel and txt-file. 

• Shapefiles must be in the correct coordinate system: EPSG 3035. 

• One shapefile can contain more than one polygon. During the analysis these polygons will be 

considered as one zone for which the same conversion rules apply. 

• Shapefiles can overlap, allowing for different conversion rules for specific subzones. 

 The different shapefiles must be placed together in one folder. It is the location of this folder that 

must be entered in the module. The module will find the correct shapefile from the txt-file with the 

conversion rules. 

The txt-file that is required can be created in the Excel document 'Scenario_Template' that is supplied 

with the database. With this Excel file, the user can set up a series of conversion rules that allow the 

development of alternative scenarios and indicate what needs to be changed within each shapefile. 

Each line is associated with a shapefile, whereby according to the coding it is indicated which current 

land cover classes should be replaced by an alternative. The user can create as many rules as he/she 

wants. Using the “Scenario Table” tab, it is easy to set up the scenarios by means of drop-down 

selections (Figure 4). An overview of the codes of the land cover map can be found in the same Excel 

and in appendix 1. The list must then be copied, without a header, to the txt-file. Cut and paste the 

excel selection in e.g. notepad and save this file. The columns must be delineated with tabs. This txt-

file must be defined via the user interface of the QGIS scenario module. It is possible to check the txt-

file by going to the tab ‘Conversion rules’. Extra rules can also be added here after which the updated 

text can be saved. 

 

Figure 4: Screenshot of Scenario_Template with drop-down menu 

The conversion rules must comply with several rules to apply the correctly: 

• The naming of the shapefiles is largely free (numbers and/or letters). However special 

punctuation marks such as ^ and ¨ can cause problems. 
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• Different rules can be drawn up for one shapefile. In the same area (of one shapefile), for 

example, forest can be converted to a swamp type in a first line and grassland to an arable 

type in a second line. 

• The letter X acts as a wildcard. Using 'X' instead of a more specific code in the "Current State" 

ensures that all more specific codes (under the 'X') are included in the conversion. For 

example, entering '21XX' will select all areas with codes 2100, 2110, 2120, etc. for conversion 

by the module. With 'XXXX' the entire area is included within the delimitation of the shapefile, 

regardless of the current coding. 

• For the “Future State” land cover must always be specified to the highest level of detail. For 

example, it is not possible to enter 21XX as new land cover. 

• The list of conversion rules is run from top to bottom. If a pixel is converted by several lines, 

the last conversion line takes precedence. It is therefore best to place large land cover changes 

at the top and the more detailed changes at the bottom. 

• If the desired type of land cover is not available or cannot be defined, 65535 can always be 

entered as a no data area.  

 

4.1.3. Adapting groundwater levels 

 
Part of the scenario is also adapting the groundwater levels to a new status quo. The next module 

drainage will take into account some effects of new land cover, however apart from land cover 

changes certain measures will have a more profound effect on groundwater levels. Examples are the 

installation of leaky dams (rewetting larger areas around it), the creation of floodplains or the filling 

up off ditches. These adaptations will require the user to manually adapt the MHG/MLG values.  

 

How to adapt MHG/MLG in QGIS: 

If the complete area of the case study should be adapted with a flat rate, this can be easily done 

through the raster calculator (under the raster tab). However if more complex changes need to be 

made things become more difficult. 

 

Required information in the module 

  Module Type Description 

1 Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map which needs to be adapted 

3 

Give location and name of 

the updated land cover 

(Tiff) 
Tiff 

Give the location and name for the new land cover map. 

This file will be created or overwritten if it already exists. 

4 Select the txt-file with 

conversion rules (txt) 
Txt Select the txt-file with the different conversion rules. 

5 
Select the folder with the 

different areas (folder) Folder 
Give the folder which contains the shapefiles that are 

given in the txt-file with conversion rules. 
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In our calculations of study sites, certain rules of thumb were used. Around measures such as leaky 

dams, wetland scrapes or the filling up of ditches we chose to create a buffer of 50 meter combined 

with a rewetting of 10 cm inside (both for MHG and MLG). If site data is available , it is always better 

to use that information. 

An example is the demonstration site of Walkhampton, where 8 leaky dams were installed. The leaky 

dams will slow down run-off, causing more infiltration, which can cause the MLG and MHG to increase 

locally around these dams.  

First buffers should be made around the newly installed leaky dams. Take a shapefile with only the 

leaky dams and add a buffer through “Vector -> Geoprocessing Tools > Buffer”, where a distance for 

the buffer can be specified e.g. 50 meter. If specific local data is present this can be used to determine 

an exact buffer distance.   

It is also possible to define your own polygon if you don’t expect the same effect on both sides of the 

measure. This can be done through “Layer -> Create Layer -> New Shapefile Layer”. Provide a name, 

select geometry type polygon and select coordinate system EPSG 3035. Right click the new layer, 

toggle editing and then click on “Add polygon feature” which can be found under the tab “Edit” or in 

the Digitizing Toolbar. You can now make a polygon by clicking on the map and finalise it by right 

clicking.    

In a next step the buffer should be joined with the original shapefile of the area (in case the buffers 

extend beyond the original) through “Vector -> Data Management Tools > Merge Vector Layers”. This 

new shapefile can then be used in the first step of the ES-tool to extract MHG, MLG and land cover. 

A simple way to adapt the groundwater in the buffer only with a flat rate can be done in the following 

way: 

1. Create a new column in the (multi)polygon with only the buffers, where you put the number 

of the change needed in the groundwater level. For this opten the attribute table of the 

polygon click on the pencil at the top left and then either click on ‘open field calculator’. Give 

an output field name and add the number of the change in groundwater level. Save the edit 

(click on the pencil again). 

2. Save the edit  

3. Raster -> Conversion -> Rasterize. Select the polygon and column you just adapted, choose as 

output raster size units georeferenced units of 10 by 10. Select as output extent a layer that 

selects the whole site. Don’t choose 0 as NoData value but choose something as 65535. 

4. Go to raster tools, select Fill No Data cells and fill it with 0.  

5. Now you can adapt the original groundwaterlevels obtained through the ‘extract case study’ 

of the plugin with raster calculator by adding or subtracting the change. (Rewetting means 

subtracting from the original values.  

Another way of doing it is: 

1. In order to change the MHG and MLG inside the buffers around the leaky dams but not in the 

rest of the site, start by extracting data from the original groundwater rasters with the buffer 

shapefile as mask (Raster -> Extraction ->  Clip Raster By Mask Layer). Turn off the option 

‘Match the extent of the clipped raster to the extent of the mask layer’ 
2. Adapt this new raster through the raster calculator.  
3. Open the raster calculator again and create a mask by dividing the adapted layer by itself. This 

will create a raster with 1’s where the buffers are located and NoData cells outside of it.  
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Note: if a value of  0 is present in the raster, adapt the raster by adding a constant number to 

both sides in order to avoid dividing zero by zero. 
4. Search in the Processing Toolbox for the raster tool ‘Fill NoData Cells’ and use a value of zero 

to fill the NoData cells in the mask (to create a ‘Filled mask’). This creates a binary raster with 

zeroes and ones. 
5. Open the raster calculator and use ‘original layer * (1- Filled mask)’ in order to create a raster 

with the original values that need to be kept. It is possible to do calculations with this layer as 

well. 
6. Use the Fill No Data Cells on the layer with the adapted values inside the buffer and fill the no 

data with 0.  
7. This layer can then be summed together with the layer with the values outside the buffer in 

order to have a complete layer, with adapted MHG or MLG values. 

Important: MHG and MLG values are positive when underneath the ground level. In order to raise the 

groundwater level it is thus necessary to subtract a number from the original values. A raise of the 

MHG with 20 cm equals “MHG – 20” in the raster calculator. 

 

4.2. Ecosystem services 

 
In this part of the tool different maps with a quantification of different ecosystem services will be 

calculated. This makes it possible to examine in detail in which part of the sites the potential delivery 

of ecosystem services is the highest. 

4.2.1. Drainage 

 
Description 

To make land uses such as agriculture, urban developments or forestry possible, ground water tables 

need to be stable and remain under certain ground water depths. These depths vary between land 

uses as trees require different levels compared to crops. Drainage systems, such as ditches, remove 

excess rainwater fast and reduce ground water tables to these specific levels. But lowering ground 

water tables influences a range of ecosystem services, from ground water recharge up to carbon 

storage in the soil. To estimate the impact of drainage on these services, changes in land cover need 

to be translated into groundwater table changes. This module calculates new mean high and low 

groundwater table maps and estimates the losses in groundwater in the upper soil layer compared to 

the natural situation. The effect of these changes can then be evaluated in the ES modules by 

implementing these new mean high and low groundwater table maps. 

Method 

The module compares the mean low and high ground water levels from the tiff-files with a table with 

maximum ground water levels.  For each land use type a high and low estimate of the maximum 

ground water level is given above which the land use can become compromised (e.g. reduced crop 

production). The user can change these ground water levels to the local situation. The values from the 

table are combined with the land cover map and MHG map, to assess which areas have to be drained 

to make the land use possible. The differences between the MHG map and land use targets are 

aggregated to give an high and low estimate of the ground water volume that needs to be drained to 

keep the ground water during the wet season below the target levels.  
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The module also creates new MHG and MLG maps where the ground water levels are decreased to 

the mean value of the high and low target levels. These maps can then be used to calculate the effect 

of the drainage on the other ecosystem services. The module only takes into account the effects from 

drainage, a reduction in groundwater levels. Measurements to artificially increase the ground water 

level are not considered. 

Important: In case of rewetting of an area, it might be necessary to add the rewetting after running 

the drainage module. This is because the tool has a low and high target of groundwater level. If the 

area is rewetted, it might simply be reduced to the same level as before, not reflecting the original 

situation. However it is important to realise that in such cases for example crop or forest growth will 

be impacted. 

 

Required information in the module 

 Module Type Description 

1 Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map of the study site. 

3 Select mean high groundwater 

(Tiff) 
Tiff Select the mean high ground water map of the 

study site. This map will be adapted by the 

module. 4 Select mean low groundwater 

(Tiff) 
Tiff Select the mean low ground water map of the 

study site. This map will be adapted by the 

module. 
5 

Give location and name for the 

output minimum drainage losses 

file (Tiff) 

Tiff 
Give location and name of the map with the new 

ES minimum drainage loss. This file will be 

created or overwritten if it already exists. 

6 
Give location and name for the 

output maximum drainage losses 

file (Tiff) 

Tiff 
Give location and name of the map with the new 

ES maximum drainage loss. This file will be 

created or overwritten if it already exists. 

7 
Give location and name for the 

new MHG file (Tiff) 
Tiff 

Give location and name of the map with the new 

MHG. This file will be created or overwritten if it 

already exists. 

8 
Give location and name for the 

new MLG file (Tiff) 
Tiff 

Give location and name of the map with the new 

MHG. This file will be created or overwritten if it 

already exists. 

 Optional Type Description 

9 LC - Drainage Txt Table with low and high drainage estimates. Can 

be adapted for each land cover. Provided in 

geodatabase.  
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4.2.2. Soil carbon 

 
Description 

The ecosystem service soil carbon storage results from the storage of non-mineralized carbon from 

dead organisms in the soil, where it is stored in the long term. The more atmospheric CO2 is captured 

in the soil, the less it can contribute to global warming. The benefits of this service are on the one 

hand the preservation of existing carbon stocks and on the other hand the storage of extra carbon in 

the soil. This module calculates the total carbon storage in the soil (ton C / ha). 

Method 

The module uses 4 different regression equations that were originally developed for Flanders (Ottoy, 

Beckers et al. 2015; Ottoy, Elsen et al. 2016; Ottoy, De Vos et al. 2017; Ottoy, Van Meerbeek et al. 

2017 ) and now adapted to better fit the wider region. Together, these equations allow to calculate 

the carbon storage in the soil for most land cover types down to a depth of 1 meter. The regression 

equations are based on the most reliable databases available for Flanders.  

From these equations and the available data within the module, the carbon storage in the soil can 

then be calculated to a depth of 1 meter (ton C/ha). To calculate the storage per year in the quick scan 

it is assumed that it takes 100 years to convert a carbon stock to a new equilibrium state (Foereid and 

Høgh-Jensen 2004; Freibauer, Rounsevell et al. 2004). If extra field data is available with the 

percentage of soil organic carbon, sand or clay in the upper soil layer, these data can be added under 

the optional tab of the module. 

Required information in the module 

  Module Type Description 

1 
Select the location of the 
PROWATER database 

Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map of the study site. 

3 
Select mean high 

groundwater (Tiff) 
Tiff Select the mean high ground water map of the study site. 

4 
Select mean low 

groundwater (Tiff) 
Tiff Select the mean low ground water map of the study site. 

5 

Give location and name for 

the carbon output file (Tiff) Tiff 

Give location and name of the map with the new ES soil 

carbon. This file will be created or overwritten if it 

already exists. 

 Optional Type Description 

6 

Select areas with increases in 

SOC (%) (Shp) Shp 

Provide a shapefile with the areas in which there is an 

increase in Soil Organic Carbon. The amount should be 

added as a column in the attribute table. 

7 Select field (%) Field 

in Shp 

Select the field of the attribute table of the above 

shapefile with the % of Soil Organic carbon. 

8 
Select amount of sand in the 

upper soil layer (%) (Tiff) Tiff 
Select a map with the percentage of sand in the upper 

soil layer. The coordinate system should be EPSG 3035. 

9 
Select amount of clay in the 

upper soil layer (%) (Tiff) Tiff 
Select a map with the percentage of clay in the upper soil 

layer. The coordinate system should be EPSG 3035. 
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4.2.3. Nitrogen and phosphorus in the soil 

 
Description 

Ecosystems can filter nutrients from soil and surface water and incorporate them into the organic 

matter (living, litter, humus and organic matter). These nutrients end up in litter, after which 

mineralization and decomposition processes make it available again for plants. This process will also 

ensure that soils are enriched with organic material. This organic material also contains some nutrients 

(N/P). In this way they can remove N and P from the groundwater and surface water for a long time, 

improve the quality of both and provide numerous direct (e.g. pure water) and indirect benefits (e.g. 

water recreation). This module calculates the total N and P storage (tons N/ha and tons P/ha) in the 

soil. 

Method 

The storage of nitrogen and phosphorus in soils is directly linked to the storage of carbon in soils. For 

the different soil cover classes, C/N and N/P ratios were taken from the report “benefits of the 

NATURA2000 network” (Broekx et al., 2013). These ratios are then used to calculate the storage of N 

and P in the soil from the carbon map from module 2.2. 

Required information in the module 

  Module Type Description 

1 Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map of the study site. 

3 Select soil carbon (Tiff) Tiff Select the soil carbon map of the study site. 

4 

Give location and name 

for the output nitrogen 

file (Tiff) 
Tiff 

Give location and name of the map with the new ES soil 

nitrogen. This file will be created or overwritten if it already 

exists. 

5 
Give location and name 

for the output 

phosphorus file (Tiff) Tiff 

Give location and name of the map with the new ES soil 

phosphorus. This file will be created or overwritten if it 

already exists. 

 

4.2.4. Infiltration – evapotranspiration – runoff 

 
Description 

The infiltration or seepage of rainwater into the soil is an important supporting ecosystem function. 

Infiltration assures us of sufficient ground and surface water of good quality. Once deeply infiltrated 

into the soil, the water will slowly continue its way to deeper groundwater layers over a long period 

of time. The long residence times of groundwater mean that pollutants and nutrients are removed by 

adsorption, soil chemical processes and microbial processes. Groundwater will largely return to the 

surface in seepage zones and thus contribute to a stable and clean basic flow of our waterways. The 

module calculates the amount of water that infiltrates locally annually (m³/ha*year). 
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Method 

Water infiltration is partly determined by the physical system and partly by soil cover and use. Several 

physical factors together determine a maximum potential infiltration. This potential is then reduced 

by the land cover to the actual infiltration. The module combines the spatial information from the 

study site with yearly estimates for evapotranspiration, runoff and infiltration from a database 

considering the physical system, land use and land management options for five rainfall scenarios. 

These estimates were calculated using an hourly stepwise 2-D model which contains both land cover 

and the upper soil layer. A general overview of the model is given in Figure 5.   

The model simulates both above and below ground physical and biological processes and can be 

applied on a number of natural vegetation types, grassland, crop types as well as different types of 

impervious land cover types on different soil types (sand, loam, sandy loam and clay). 

 

Figure 5: General overview of the infiltration model. 

 

Figure 6: Spatial output of the model. Through different pathways in the model, precipitation totals are divided between 
evapotranspiration, runoff and recharge (deep infiltration). Runoff requires interpretation because secondary/delayed 
infiltration/evaporation can occur.  



 

20 
 

 

Figure 7: Conceptual representation of how precipitation is divided between Runoff, Evapotranspiration and 
Infiltration/recharge. The red/black dot shows a potential shift after implementation of resp. afforestation (left) and soil 
decompaction (right). 

To develop the database the model was applied under a wide range of conditions, as a result the 

following options are integrated in the database and module: 

• Rainfall scenarios 

Five rainfall scenarios were derived from rainfall measurements in Flanders over the last 10 years. 

These scenarios were developed as monthly rainfall-length-intensity probability distributions. From 

these distributions 500 rainfall series were simulated which were run in the model to get average 

yearly values for evapotranspiration, runoff and infiltration: 

o Average precipitation (803 mm / year) 

o Low precipitation (635 mm / year) 

o High precipitation (1150 mm / year) 

o Average precipitation - dry summer/wet winter (794 mm / year) 

o Average precipitation - Wet summer/dry winter (817 mm / year) 

The user should compare these scenarios with rainfall distributions within the research area to assess 

potential differences in outcome and their impact on evapotranspiration, runoff and infiltration. 

• Changes in land cover 

Changing the land cover map will allow the user to assess the impact of land cover conversion. The 

available land cover classes allow the user to evaluate a wide range of land cover types as well as 

mixed land covers such as open forest and heath land with dunes. 

• Changes in drainage 

Infiltration capacity is affected by the depth of the ground water level. Areas with high ground water 

levels such as wetlands have limited capacity to store rainwater during rain events and high runoff 

values. To take this effect into account mean high and low ground water maps are used to limit the 

amount of infiltration in areas with high ground water levels and increase runoff. 
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• Soil carbon content 

Soil carbon content has an impact on the water holding capacity of the soil and effects as such the 

infiltration capacity of the soil. Therefore, the soil carbon map from the soil carbon module is required 

to calculate the infiltration correctly. Improvements in soil carbon content can increase the amount 

of water which can be retained in the soil layers. By changing the soil carbon content within an area 

in this map manually, the impact of management some options can be evaluated. 

• Soil compaction 

The use of heavy equipment on agriculture and forestry can lead to compaction of the soil. Especially 

on arable land the effect can be found as a plow pan directly beneath plow depth. In the module a 

shapefile can be given with areas where soil compaction is present. The module can evaluate four 

different conditions: 

• 0 – No compaction = natural infiltration rate 

• 1 – Low compaction = reduction of infiltration rate by 27% beneath the lower soil layer. 

• 2 – Medium compaction = reduction of infiltration rate by 65% beneath the lower soil layer. 

• 3 – High compaction = reduction of infiltration rate by 82% beneath the lower soil layer. 

The values 0 – 4 need to be given in a column in the compaction shapefile to define the level of 

compaction for each polygon. 

• Soil texture 

Soil texture is currently coded as a percentage adding up to 100. This map should have 4 bands. Band 

1 = loam,  Band 2= Sand; band 3 = Clay; band 4 = sandy loam, each band between 0 and 100. 

Required information in the module 

  Module Type Description 

1 Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map of the study site. 

3 
Select mean high 

groundwater (Tiff) 
Tiff Select the mean high ground water map of the study site. 

4 
Select mean low 

groundwater (Tiff) 
Tiff Select the mean low ground water map of the study site. 

5 Select soil carbon (Tiff) Tiff Select the soil carbon of the study site (created in 2.1) 

6 Select climate scenario  Select 1 of the 5 climate scenarios. 

7 
Give location and name for 

the output infiltration file 

(Tiff) 
Tiff 

Give location and name of the map with the new ES infiltration. 

This file will be created or overwritten if it already exists. 

8 
Give location and name for 

the output 

evapotranspiration file (Tiff) 
Tiff 

Give location and name of the map with the new ES 

evapotranspiration. This file will be created or overwritten if it 

already exists. 

9 
Give location and name for 

the runoff infiltration file 

(Tiff) 
Tiff 

Give location and name of the map with the new ES runoff. This 

file will be created or overwritten if it already exists. 
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 Optional Type Description 

10 Select areas with 

compaction (code) (Shp) Shp 

Provide a shapefile with the areas in which there is soil 

compaction. The amount should be added as a column in the 

attribute table. 

11 Select field (code) 
Field in 

shp 

Select the field of the attribute table of the above shapefile with 

the code of Soil Compaction (0-3).  

12 
Give texture (Tiff) Tiff 

Select a map with the soil texture (as a percentage). This map 

does not have to be clipped on the study site (as long as it is in 

EPSG 3035) 

 

4.2.5. Water retention 

 
Description 

Water retention in shallow groundwater involves the (temporary) retention of rainwater which is an 

important regulating function. Water retention has positive effects on peak drainage (increased 

storage) and in periods of drought (water retention, sponge effect). Water retention as a supporting 

function strongly determines ecosystem services such as denitrification, carbon storage in soils and 

the associated nutrient retention. Water retention is influenced by soil characteristics, drainage and 

land use (desired drainage). On the one hand, the module calculates the possible buffering of 

precipitation surplus between seasons (difference between the average highest and lowest 

groundwater level) and, on the other hand, the water buffer that is still available in the event of a 

prolonged drought (m³ of water present in the first meter below ground level). 

Method 

Water retention is determined based on the differences between the MHG and MLG maps. An 

indicator is given of the seasonal retention (variations between winter and summer levels) and 

permanent retention available during prolonged drought up to 1 meter below ground level. Both maps 

give values in m³ per hectare. 

Permanent retention refers to the intrinsic capacity to deliver water to surface water in the event of 

extreme drought. This is reflected by the total amount of water that is present up to 1 meter below 

ground level in the situation of the average lowest groundwater level. This limit to 1 meter below 

ground level is under the assumption 1 meter is a permanent drainage depth. The permanent 

retention is thus especially high for areas that are extremely and/or permanently wet. It is the capacity 

for water-supply capacity to surface water in the event of extreme low water and NOT in function of 

flood prevention. If permanent retention is high, there is often a very low capacity to receive extreme 

precipitation. 

 

- Formula for permanent retention: (100-MLG)/2) *100 
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Seasonal retention refers to the capacity to buffer soil water between periods of high and low rainfall. 

It is determined by the difference between the average highest and the average lowest groundwater 

level. Here too this is limited to a maximum of 1 meter below ground level. Areas that combine a high 

winter/spring groundwater level with a low summer groundwater level have a high seasonal 

retention. These are often temporary wet areas in upstream depressions in the landscape. In such 

areas, shallow groundwater flows and runoff water converge, causing such zones to react quickly to 

precipitation surpluses and precipitation shortages. They contribute strongly to flood prevention and 

groundwater replenishment. 

- Formula seasonal retention:  

If MLG > 100 and MHG <100: (100-MHG)/2 *100 

IF MLG AND MHG <100: ((100-MHG)-(100-MLG))/2) *100  

 

Required information in the module 

  Module Type Description 

1 
Select the location of 

the PROWATER 

database 
Folder Select the geodatabase 

2 
Select land cover 

(Tiff) Tiff Select the land cover map of the study site. 

3 Select mean high 

groundwater (Tiff) 
Tiff Select the mean high ground water map of the study site. 

4 Select mean low 

groundwater (Tiff) 
Tiff Select the mean low ground water map of the study site. 

5 

Give location and 

name for the output 

seasonal retention 

file (Tiff) 
Tiff 

Give location and name of the map with the new ES seasonal 

retention . This file will be created or overwritten if it already 

exists. 

6 

Give location and 

name for the output 

maximum retention 

file (Tiff) Tiff 

Give location and name of the map with the new ES maximum 

retention. This file will be created or overwritten if it already 

exists. 

 

4.2.6. Health benefits 

 
Description 

There is a lot of scientific evidence that greenery contributes to improving the physical and mental 

health of residents and the people who visit these areas. There are several mechanisms at play here: 

• View of and contact with nature have positive effects on mental health (stress, depression). 

•  Proximity to greenery stimulates outdoor recreation and exercise, with direct positive effects 

on health. 

• Contact with greenery improves the cognitive, physical, and social development of children. 

• Proximity to greenery reduces the risk of overweight and obesity. 

• Nature provides a specific framework of importance for care tourism. 
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Method 

The method in this module has been adopted from Broekx et al. (2013) and is based on the results of 

a scientific multi-year program in the Netherlands (Vitamin G - Maas, 2008). This study shows that 

there is a positive relationship between the amount of green area within a 1 km radius of the home 

and the reduction of 18 out of a total of 24 specifically studied disease states. The study has been 

adjusted for indirect demographic and socio-economic characteristics of the respondents and for the 

degree of urbanization. Among other things, a positive effect has been found on heart disease, neck 

and back complaints, depression, anxiety disorders, upper respiratory tract infections, asthma, 

infectious diseases of the gastrointestinal tract, urinary tract infections and diabetes. The relationship 

is greatest for mental illness. For other important diseases such as stroke or cancer, no associations 

with the presence of greenery have been found (but with traffic-related air pollution, for example). 

The relationship was strongest for population groups that are expected to spend a lot of time in the 

vicinity of their own home, such as children and groups with a lower socio-economic status. 

To estimate the relative importance of these health effects, how often they occur has to be 

investigated. Their occurrence is based on Dutch prevalence figures, which indicate how often a 

disease or condition occurs on average in 1,000 people (Hoeymans et al., 2007). To be able to compare 

and add up very different health effects, these effects are expressed in DALYs. DALYs or disability 

adjusted life years is an indicator for comparing different health effects. The indicator considers the 

severity and duration of the condition and is expressed in the number of healthy life years lost. All the 

disorders on which greenery has a positive effect together represent 40% of the total disease burden 

in the Netherlands or 74 healthy life years lost (per 1,000 Dutch people in 2007 (Hoeymans et al., 

2007). Green has a relatively large effect on some important health problems such as mental problems 

(anxiety and depression), coronary heart disease, COPD and diabetes. 

According to the study of Maas (2008), 10% extra green space within a radius of 1 km leads to a total 

health gain of 2.46 healthy life years per 1,000 inhabitants. Green within the module includes a wide 

range of green space such as park, nature, forest and agriculture. In addition, the study by Maas also 

provides a relationship for the share of green space within a radius of 3 km around the place of 

residence and effects on mental health. Both relations are combined in the module. 

 

The following methodology is then applied in the module: 

1. Converting land cover to “Green” – “No Green”. 

2. Calculate % green within a 1km buffer around each cell. 

3. Calculate % green within a buffer of 1 to 3km around each cell. 

4.  Calculate health effect of greenery within 1km: 

➔  DALYs = number of inhabitants x %green1km x 0.000246 

5. Calculate health effect of greenery between 1km and 3km: 

➔ DALYs = number of inhabitants x %green1 to 3km x 0.000078 

6. The health effects (total DALYs) are assigned to the surrounding green. The DALY value of each 

cell is divided by the area surrounding green. This value is subsequently assigned to each green 

cell and the results of dividing all cells are added together: 

➔ Health effect of green = sum ((Health effect 1km / area green 1km) + (Health effect 

1to3km / area green 1to3km)) 
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Required information in the module 

  Module Type Description 

1 Select the location of the 

PROWATER database 
Folder Select the geodatabase 

2 Select land cover (Tiff) Tiff Select the land cover map of the study site. 

3 
Give location and name 

for the health effects file 

(Tiff) 
Tiff 

Give location and name of the map with the new ES health 

. This file will be created or overwritten if it already exists. 

 Optional Type Description 

4 
Select population 

density – inh/ha (10m 

resolution)  

Table with low and high drainage estimates. Can be 

adapted for each land cover. 

 

4.3. Evaluation  

4.3.1. QuickScan 

 
The quick scan module has been developed to aggregate the results of the ecosystem services 

calculations (map layers) in a simple way and makes a comparison between scenarios possible. This 

gives the user the opportunity to contextualize and interpret the calculated results. The tables make 

it possible to report and communicate the results in an understandable and systematic way. 

The module in QGIS aggregates all data coming from the different ecosystem services modules to total 

values for the study area. These are then presented in an understandable way in tables and graphs in 

an included Excel document. In the Excel file, the results of different scenarios for the same area can 

be brought together and compared with each other. 

To calculate the quick scan and place the results in the Excel file, the following actions must be taken: 

1. Using module 3.1 in QGIS, the data from the different data layers is aggregated into total values 

for the area. This creates 2 different txt-files. The first file the 'Ecosystem services.txt' contains the 

results of the ecosystem services calculations. The 2nd file the 'Land cover.txt' contains an 

overview of the land cover classes and is used to calculate certain averages (e.g. per ha non-

urban). If certain ecosystem services have not been calculated and are therefore not available in 

the results folder, a zero value is automatically entered in 'Ecosystem services.txt'. 

2. The scenario name and both files must then be copied to the correct places in the Excel file.  

• The scenario name entered in the module must be placed at the bottom of the list in the 

“Scenarios” tab 

• The results from ecosystem services txt must be copied to the 'Ecosystem services' tab. The 

results should be placed at the bottom of the existing list. 

• The results from the land cover tab must also be copied here to the 'land cover' tab and 

placed at the bottom of the existing list. 

After the scenario name has been entered in the correct tab, it automatically becomes available in the 

drop-down windows for selecting the study and reference area in the tab 'Overview'. If all tabs are 

filled in correctly, the results are automatically adjusted in the rest of the tables. 
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Calculate net gain or loss of water 

The quickscan module offers the difference in delivered ecosystem services in the case of 2 scenarios, 

often the current situation and a future scenario with EbA-measures implemented. If the goal is to 

calculate the total net gain or loss of water in the study site as a result of the EbA-measures, there are 

three calculations that can be done depending on site characteristics. These calculations need to be 

done with the results from the table ‘changes in ecosystem services’ (unless otherwise specified). 

Retention + Infiltration – Avg. drainage 

This equation assumes that runoff is lost to the area. However if this is not the case and runoff will 

remain in the site and infiltrate at a later time , the equation changes to: 

Retention + Infiltration + Runoff (change) – Avg. drainage  

This equation assumes that no water that initially runoffs evaporates before it infiltrate. It might be 

more realistic to add a coefficient before assuming all runoff will eventually infiltrate. This equation 

assumes that only the extra runoff will remain in the study site, however these EbA-measures will also 

influence the original runoff that already occurred.  

Retention + Infiltration + All Runoff – Avg. drainage  

In this equation the total runoff in the scenario with EbA-measures is added, instead of only the 

difference between the updated and original scenario. 

4.3.2 Case studies 

 
General remarks 

The tool has been tested on every demonstration site of the PROWATER project. Some tips and tricks 

will be given with how to best use the tool and interpret some of the results. 

• After extracting the case study area, it is important to check if the resulting values are realistic. 

This means checking the land cover map (the land cover map in the database is based on 

remote sensing) and also the MLG and MHG. If there is surface water during parts of the year, 

this should be reflected in the MHG which should be smaller than or equal to zero (as negative 

values mean water above the surface).   

• Develop scenario: It is highly likely that the land cover extracted from the database is not 

completely correct when comparing to the situation on the site. That is why it is useful to 

develop first a scenario with the correct original situation and later an adapted version to be 

able to compare the ecosystem services before and after the ecosystem based adaptations 

are in place. 

• Before the ecosystem services are calculated it can be necessary to adapt the groundwater 

levels, as these have an influence on the delivery of the ES. Choosing realistic values can be 

difficult, so having site information is recommended. Certain measures will influence a larger 

area around the implementation site with regards to the groundwater level which then needs 

to be adapted. An example is the installation of leaky dams, causing an elevation of the 

groundwater around it. However, adapting groundwater levels can be hard, especially if you 

want to do more complex calculations. Estimations will also need to be made about the area 

affected by the change.  
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• Regarding the ecosystem service runoff: The tool will often find that in wet areas only a small 

amount of water will infiltrate, causing larger amounts of runoff. However, as long as the pool 

wherein this water is stored is closed off and the water does not get drained away by ditches 

or removed by a sloped landscape, this amount of water will not be lost to the ecosystem. The 

tool only provides numbers for what initially happens, so the initial runoff can still infiltrate at 

a later time. Furthermore the amount of water in the infiltration part of the water system will 

extend a pressure which will reach those part of the water system where seepage of water 

can be observed.  

4.3.2.1 Flanders: Den Rooy 

 

In Den Rooy, a site in the Campine region with sandy soil in Flanders, a degraded bog relict was 

restored. Before any measures were in place, this bog was drained by various ditches. This bog is 

located in the north part of the site, which lies more in the wet part of the water system. Other parts 

of the site lie in the permanently dry part of the water system. This part contained pine plantations, 

which were partly removed and replaced by heathland in order to increase infiltration (Figure 8).  

  

Figure 8: Overview of the measures taken on the site in Den Rooy and its location on the watersystem map where brown- 
yellow = infiltration area and blue= floodplain. 

In a first step the before situation is calculated. As the remote sensing data is not always correct or 

specific enough it is often better to correct the land cover for the site. In the example for Den Rooy 

this means changing the land cover where the bog will be restored to heathland (code 4070) and 

setting the initial land cover of the pine forest to a more dense variant (code 2280) per data provided 

by the site partner. The resulting txt-file, loaded into the QGIS-tool can be seen in Figure 9. 
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Figure 9: Example original scenario txt-file for the site of Den Rooy. 

The next step is the calculation of the ecosystem services. In the first module of drainage the 

groundwater levels will change depending on the land cover. It is important to keep using these 

‘corrected’ groundwater levels for the other ES-modules (Figure 10). 

 

Figure 10: Example of the drainage module for the site of Den Rooy. 
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For the scenario after the ecosystem based adaptations are in place, it is important to change the 

MHG and MLG in the upper part as different ditches are filled up with bentonite, causing a diminished 

drainage and more retention of water in this part. In order to simulate this in the tool, values in the 

upper part were decreased with 20 (as the groundwater values are under ground level). However this 

value is not based on site measurements, but rather an estimation.  

The changes in land cover before and after the adaptations are present can be observed in Figure 11. 

Original heathland was changed into a pond, while coniferous forest is converted to heathland. For 

forest and heathland, it is important to make an estimation of the canopy density in order to assign 

the correct code. This should not be the current density, but the expected future density. 

The new land cover and groundwater levels can then be used to predict the adjusted ecosystem 

services after the EbA-measures are implemented. The changes in delivered ecosystem services are 

shown in Table 1. 

 

 

 

 

 

 

 

Figure 11: Land cover before (left) and after(right) EbA-measures are in place for the site of Den Rooy. 



 

30 
 

Table 1: Changes between ES delivery for the site of Den Rooy in the scenario after the adaptations are in place. 

 Ecosystem services % Total Unit 

 Original runoff  326,52 m³ / year 

Supporting and 
regulating 

Runoff (change) 83,65 273,15 m³ / year 

Soil carbon -5,83 -339,93 ton C  

Soil nitrogen -6,28 -15,57 ton N 

Soil phosphorus -6,28 -1,04 ton P 

Health effects 0 0 DALY / year 

Evapotranspiration -0,49 -75,22 m³ / year 

Minimum drainage losses 166,4 52,25 m³ / year 

Maximum drainage losses 67,85 97,43 m³ / year 

Provisioning Infiltration -1,7 -197,48 m³ / year 

Seasonal retention 15,85 1946,75 m³ / year 

Maximum retention 74,75 2762,25 m³ / year 

Net gain or loss of water* 
* Retention + Infiltration – Avg. drainage  + 4436,68 m³ / year 

Net gain or loss of water* 
If runoff> 0, remains in situ and can slowly infiltrate  

* Retention + Infiltration + Runoff (if >0) – Avg. drainage  + 4709,83 m³ / year 

Net gain or loss of water* 
 If all runoff (original + change) remains in situ and can slowly infiltrate * 

Retention + Infiltration + All Runoff – Avg. drainage  + 5036,35 m³ / year 
The impact assessment tool predicts an increase of the seasonal and maximum retention. This is a 

predictable ecosystem service resulting of the bog restoration. In the upper part of the site around 

the bog drainage ditches were closed and filled up with bentonite, resulting in the increased retention 

of water.  

Given that more water can reach the ground (after converting high interception pines to lower 

interception heathland), while at the same time the groundwater table in the part around the bog will 

rise, an increase in water runoff can be expected. This emphasises the importance of understanding 

where runoff in the landscape converges to. Ideally it ends up in the bog where it can infiltrate towards 

the groundwater from there at a later time (i.e. delayed infiltration), rather than being drained away. 

However we also see an increase in drain losses. This is to be expected as there is still a large ditch, 

called the ‘Heerlese loop’, to the northside of the area of Den Rooy, while simultaneously the 

groundwater table is elevated.  

The results with regards to the other ecosystem services are not completely in line with the 

expectations. An effect of the raised groundwater table however is that the tool predicts a lower 

infiltration, which is not fully compensated by the cutting down of forest in the lower part and 

replacing it with heathland for the corridor. 

The tool further predicts a decrease in soil carbon as a result of the cutting down of forest. In the 

model of the tool. This is not compensated by the restored bog and new heathland. The restored bog 

was in the calculations of the tool seen as a pond, but if over time the full pond is converted to a real 

bog the carbon captured by it will increase more than currently estimated. 
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4.3.2.2 The Netherlands: Vloeiweide 

 

In the ‘Vloeiweide’ site, situated in the Mark basin along the brook Bijloop a more natural water 

landscape was restored. This was done by adding sand and woody debris to give structure to the water 

flow, restoring a meander and raising of the riverbed to decrease drainage. This also increases the 

water retention in nearby flood meadows. An overview of the measures and the location on the 

watersystem map can be seen in Figure 12. 

 

Figure 12: Restoration measures in the Vloeiweide and its location on the watersystem map where brown-yellow = 
infiltration area and blue= floodplain. 

The first step in doing the analysis is checking if the original land cover and groundwater levels are 

correct. Using data of the site partner quite some changes in the land cover were made. They can be 

seen in figure 13. The various forest is replaced by a single category (dark green), areas wrongly 

categorized as cropland (yellow) are changed to agricultural and natural grassland (yellow-green and 

light green). Blue-green represents alluvial forest and red is built-up area. In order to do these 

corrections the original shapefile is split up in various smaller polygons, named after their future land 

cover value 
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Figure 13: Land cover based on original geodatabase (left) and after corrections were made based on site data (right) 

 

 

Figure 14: Example original scenario txt-file for the site of the Vloeiweide. 
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The further calculations of the ecosystem services is straightforward and can be done with the help of 

this manual and the video.   

The scenario after the adaptations are in place needs to be done more carefully. Not only does the 

land cover change (Figure 15), but also groundwater levels and the ground level itself change. This is 

because certain parts are either lowered or raised. However this can’t be added directly, but can only 

be added in reference to the water level. This means that if 5 cm of topsoil is removed, this can be 

translated as a raise of 5 cm of the groundwater level means subtracting 5 of the current level (as the 

value of groundwater level is cm under ground level). In figure 16 you can see that the groundwater 

becomes deeper where the Bijloop used to flow, while the groundwater level rises in other parts of 

the catchment. 

 
Figure 15: Land covers after the restoration measures are in place. Figure 16: Change in MHG values. 

When all the ecosystem services are calculated with the tool, the overall change can be seen in table 

2. In the table a large increase in the maximum retention of the site is clear. However the exact number 

depends on the chosen groundwater table in the tool and can be further adjusted in the tool if more 

site information is available in order to do more accurate predictions. Changes in weir management 

are not possible to incorporate into the tool, but will also have an effect on water retention in the 

area. 

The (permanent) heightening of the groundwater table by various measures taken in the Vloeiweide 

will also have an effect on other ecosystem services. One such effect is that there is less room for 

immediate infiltration of water. Therefore, the tool expects infiltration to decrease slightly. Coupled 

with this, an increase in water runoff can be expected. This emphasises the importance of 

understanding where runoff in the landscape converges to. In the Vloeiweide, ditches are present who 

will lead the water deeper into the floodplain combined with weir management in order to make sure 

this runoff will not be lost but spread out over the site if the weirs are closed. As such we can expect 

this initial runoff to slowly infiltrate over time towards deeper groundwater bodies (i.e. delayed 

infiltration). This is not modelled by the tool.   
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At first glance the result from drainage seems contradictory with the raised riverbed, as drainage 

increases. However this result takes into account the increased groundwater level after the ecosystem 

based adaptations are in place. For this the water level was manually raised. If this is not done, the 

drainage will actually decrease. As such the increased drainage is an effect of the increased water 

retention in the Vloeiweide.  

Table 2: Changes between ES delivery for the site of the Vloeiweide in the scenario after the adaptations are in place. 

 Ecosystem services % Total Unit 

 Original runoff  6459,62 m³ / year 

Supporting and 
regulating 

Runoff (change) 29,13 1881,42 m³ / year 

Soil carbon 0,99 147,04 ton C  
Soil nitrogen -4,36 -32,88 ton N 
Soil phosphorus -4,36 -2,19 ton P 
Health effects 1,53 2605,71 DALY / year  
Evapotranspiration 0,02 8,12 m³ / year 
Minimum drainage losses 35,44 85,09 m³ / year 
Maximum drainage losses 4,79 28,84 m³ / year 

Provisioning Infiltration -6,47 -1887,23 m³ / year 
Seasonal retention -15,54 -12750,4 m³ / year 
Maximum retention 90,99 34653,84 m³ / year 

Net gain or loss of water* 
* Retention + Infiltration – Avg. drainage + 19959,24 m³ / year 

Net gain or loss of water* 
If runoff> 0, remains in situ and can slowly infiltrate  

* Retention + Infiltration + Runoff (if >0) – Avg. drainage  + 21840,66 m³ / year 

Net gain or loss of water* 
 If all runoff (original + change) remains in situ and can slowly infiltrate  

* Retention + Infiltration + All Runoff – Avg. drainage  + 28300,28 m³ / year 
 

4.3.2.3 United Kingdom: Moat Farm 

 

In the subsite of Moat Farm, part of the Beult catchment in the United Kingdom, two temporal 

wetlands were restored by filling up 2 ditches. Moat Farm lies at the top of the catchment (in 

Shadoxhurst) in the ‘seasonally wet’  zone of the watersystem map. Local runoff gives rise to a number 

of streams that form part of the headwaters of the river Beult. The first ditch was located in woodland, 

the other in agricultural land.  

A small catchment area used to feed a seasonally dry, over-deep woodland channel. During flow 

periods, this drained water quickly out of a potential wetland, carrying sediment from a byway 

upstream and contributing to high flows downstream. To restore the retention function, trees were 

cleared around the channel to bring light in and make woody material available; 200m of the channel 

were filled in using clay from the site; a pond was dug and large woody debris was placed across the 

flow path of water. This has wetted up the woodland area, spilling water into the floodplain and 

transforming it into a wet water retaining woodland habitat with dense vegetation. 
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Figure 17: Overview of the measures taken on the site of Moat Farm with the land cover of the geodatabase.  

 

Figure 18: Moat Farm location on the watersystem map where brown- yellow = infiltration area and light-blue= temporary 
wet. 
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In this case it is important to not only change the land cover in the area where the ditch is filled up, 

but also use a buffer around it, as this area will receive the effects of rewetting. The exact value of the 

buffer depends on site condition, but in this case there was opted for a buffer of 50 meters. Figure 19 

shows the original land cover inside the buffer after it was changed according to the provided site 

data. Figure 20 shows the land cover after the adaptations. This means changing the woodland to 

alluvial forest and the agricultural grassland to marshland. 

 

In the next step it is important to adapt the groundwater values to the new situation. Due to the filling 
up of the canal, the area will be significantly rewetted. The original groundwater levels (Figure 21) 
strongly vary between the sites and are strongly affected by the canals. When the groundwater level 
was raised this was done gradually so higher values (deeper groundwater) were diminished more than 
the lower values (groundwater closer to ground level). This adaptations result in the groundwater 
values in Figure 22. 

 

Figure 20: Land cover, after it was adapted to site data and a 
buffer of 50 m was applied. 

Figure 19: Land cover after the EbA-measures are in place in the Moat 
Farm site. 
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The difference in delivered ecosystem services before and after the EbA-measures are in place can be 

seen in Table 3. An increase in the water retention of the site is a result of the temporal wetland 

restoration measure of which the increase in seasonal retention is the highest, while the 

maximum retention almost remains constant. 

Due to the rewetting of the area, higher groundwater tables are present. This decreases the 

potential infiltration as the tool sees this as less room to infiltrate and the tool predicts a slight 

decrease. Due to the rewetting, we also expect more evapotranspiration to take place as 

former forest and (agricultural grassland is changed to alluvial forest and marshland. We 

expect a small decrease in runoff. It is however important to also look at the original runoff 

and  where in the landscape it converges to. In this case at the end of the filled up channel a 

pond is created from which it will not be drained away through ditches or other means. As 

such we can expect this initial runoff water to slowly infiltrate over time towards deeper 

groundwater bodies (i.e. delayed infiltration).  

The creation of the wet forest area and the conversion of grassland to wet nature will increase 

the carbon captured in the area. Soil nitrogen and phosphorus are also expected to increase. 

Drainage losses will almost completely disappear as an effect of the rewetting of the area.  

 

 

 

Figure 22: Adapted groundwater levels for the site of 
Moat Farm. 

 

 

Figure 21: Original groundwater levels for the site of 
Moat Farm. 
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Table 3: Changes between ES delivery for the site of Moat farm in the scenario after the adaptations are in place. 

 Ecosystem services % Total Unit 

 Original runoff  941,67 m³ / year 

Supporting and 
regulating 

Runoff (change) -7,31 -68,88 m³ / year 

Soil carbon 33,44 556,31 ton C  
Soil nitrogen 20,54 17,49 ton N 
Soil phosphorus 20,54 1,17 ton P 
Health effects 0,00 0,00 DALY / year  
Evapotranspiration 3,10 97,08 m³ / year 
Minimum drainage losses -100,00 -41,29 m³ / year 
Maximum drainage losses -99,67 -107,34 m³ / year 

Provisioning Infiltration -1,53 -24,75 m³ / year 
Seasonal retention 20,95 1705,75 m³ / year 
Maximum retention 43,61 1241,50 m³ / year 

Net gain or loss of water* 
* Retention + Infiltration – Avg. drainage  + 2996,82 m³ / year 

Net gain or loss of water* 
If runoff> 0, remains in situ and can slowly infiltrate  

* Retention + Infiltration + Runoff (if >0) – Avg. drainage  + 2996,82 m³ / year 

Net gain or loss of water* 
 If all runoff (original + change) remains in situ and can slowly infiltrate  

* Retention + Infiltration + All Runoff – Avg. drainage  + 3869,61 m³ / year 
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Appendix 1: List of possible land covers 
Possible Land covers 

1100 - Undefined green 

2100 - Broadleaf forest of unknown density 

2110 - Broadleaf forest 10-20 % canopy density 

2120 - Broadleaf forest 20-30 % canopy density 

2130 - Broadleaf forest 30-40 % canopy density 

2140 - Broadleaf forest 40-50 % canopy density 

2150 - Broadleaf forest 50-60 % canopy density 

2160 - Broadleaf forest 60-70 % canopy density 

2170 - Broadleaf forest 70-80 % canopy density 

2180 - Broadleaf forest 80-90 % canopy density 

2190 - Broadleaf forest 90-100 % canopy density 

2200 - Coniferous forest of unknown density 

2210 - Coniferous forest 10-20 % canopy density 

2220 - Coniferous forest 20-30 % canopy density 

2230 - Coniferous forest 30-40 % canopy density 

2240 - Coniferous forest 40-50 % canopy density 

2250 - Coniferous forest 50-60 % canopy density 

2260 - Coniferous forest 60-70 % canopy density 

2270 - Coniferous forest 70-80 % canopy density 

2280 - Coniferous forest 80-90 % canopy density 

2290 - Coniferous forest 90-100 % canopy density 

2310 - Undefined forest 10-20 % canopy density 

2320 - Undefined forest 20-30 % canopy density 

2330 - Undefined forest 30-40 % canopy density 

2340 - Undefined forest 40-50 % canopy density 

2350 - Undefined forest 50-60 % canopy density 

2360 - Undefined forest 60-70 % canopy density 

2370 - Undefined forest 70-80 % canopy density 

2380 - Undefined forest 80-90 % canopy density 

2390 - Undefined forest 90-100 % canopy density 

3100 - Grassland 

3200 - Natural grassland 

3300 - Agricultural grassland 

4010 - Moors and heathland 10-20 % canopy density 

4020 - Moors and heathland 20-30 % canopy density 

4030 - Moors and heathland 30-40 % canopy density 

4040 - Moors and heathland 40-50 % canopy density 

4050 - Moors and heathland 50-60 % canopy density 

4060 - Moors and heathland 60-70 % canopy density 

4070 - Moors and heathland 70-80 % canopy density 

4080 - Moors and heathland 80-90 % canopy density 

4090 - Moors and heathland 90-100 % canopy density 

4000 - Moors and heathland 

5100 - Dunes and beaches 

6100 - Cropland (probably) 

6101 - Cropland (certain) 
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6102 - Cropland (Corine) 

6200 - Orchards 

6300 - Vineyards 

7100 - Swamp 

7200 - Marshland 

7300 - Alluvial Forest 

8100 - Tidal mudflats 

8200 - Tidal marshes 

9010 - Urban 10-20 %paved 

9020 - Urban 20-30 % paved 

9030 - Urban 30-40 % paved 

9040 - Urban 40-50 % paved 

9050 - Urban 50-60 % paved 

9060 - Urban 60-70 % paved 

9070 - Urban 70-80 % paved 

9080 - Urban 80-90 % paved 

9090 - Urban 90-100 % paved 

10000 - Water 

10100 - Surface water 

10200 - Tidal water 

10300 - Rivers and canals 

10400 - Sea 

11000 - Bare rocks 

65535 - No data 
 

 


